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1 Welcome to Perfect Effects Free

Welcome to Perfect Effects Free

Add a heavy dose of excitement or a subtle amount of elegance to your photos with Perfect Effects 4
Free. Choose from over 70 effects to enhance and stylize your images, including effects to create the
popular HDR and vintage looks, textures to add depth and dimension, and borders to add a finishing
touch. Instantly add any effect with a single click or combine them to create a look of your own.
Perfect Effects 4 Free can be used as a standalone or directly with Adobe Lightroom, Photoshop,
Photoshop Elements, or Apple Aperture.
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Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.
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Using the Help System
This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.
You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.
If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual
You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.
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Contacting onOne Software
At onOne Software, we value our customers and offer a variety of ways to be contacted.
• Visit our company website at:
www.onOnesoftware.com

• For technical support please visit:
www.onOnesoftware.com/support

onOne Software, Inc.
15333 SW Sequoia Parkway Suite 150
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

© 20072013 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom, Flash and Adobe Acrobat are either registered trademarks or trademarks of Adobe Systems,
Incorporated in the United States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other
countries. Microsoft, Windows, Windows Vista, Windows 8 and .NET are registered trademarks of Microsoft Corporation. All other trademarks are the property of their
respective owners. The activation system used by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file
installed with the software.
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Additional Help

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.
Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.
Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.
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System Requirements

Recommended
Minimum

Operating
System

Mac OSX
Mac OSX 10.6, 10.7, 10.8
(current maintenance releases, 64 bit)

Mac OSX
Mac OSX 10.7, 10.8
(current maintenance releases, 64 bit only)

Windows
Windows Vista, Windows 7 or Windows 8
(current maintenance releases, 32 and 64 bit)

Windows
Windows, Windows 7
or Windows 8
(current maintenance releases, 64 bit)

Processor

Intel Core 2 Duo, Xeon or better processor(s)

Quad-core Intel Core i5, Xeon or better processors(s)

RAM

4 GB RAM

8+ GB RAM

Hard Drive

1.5 GB for installation

1.5 GB for installation
Fast 7200 RPM or SSD drives

Display

OpenGL 2.0 compatible video card with 256 MB dedicated
video RAM
1280x720 resolution

OpenGL 4.0 compatible video card with 1GB dedicated video RAM
1920x1080 resolution

Optional
Application
Integration

Adobe® Photoshop® CS4, CS5, CS6, CC
Adobe® Photoshop® Elements 9, 10, 11
Adobe® Lightroom® 2, 3, 4, 5
Apple Aperture 2.1, 3

Adobe® Photoshop® CS5, CS6, CC
Adobe® Photoshop® Elements 10, 11
Photoshop® Lightroom® 4, 5
Apple Aperture 3

Other

Internet connection for activation, auto update checking,
online help, content downloads and tutorials.

High-speed internet connection for activation, auto update
checking, online help, content downloads and tutorials.
Wacom tablet for pressure sensitive input.
Hardware display calibration tool.

About Windows Video Cards
If you are using Perfect Photo Suite from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the
best performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or
more of dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
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Installation
To install Perfect Photo Suite, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne
Software website or it may be on a DVD if you elected for a physical shipment.

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.
Mac OSX
The application is installed in the Perfect Photo Suite folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Photo Suite is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.
Windows
The application is installed in the Perfect Photo Suite directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Photo Suite is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling
To uninstall Perfect Photo Suite, follow these instructions.

You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.

Mac OSX
1. Go to the Applications/Perfect Photo Suite/Documentation folder.
2. Double click on the Remove Perfect Photo Suite application.
Windows
1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Photo Suite and then click on the Uninstall button.
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Licensing and Registration
Perfect Photo Suite will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Photo Suite, you will want to license it so
you can continue to use it past the trial period. When you install Perfect Photo Suite it will prompt you to license it. Simply click on the license button and enter
your license code. Your license code can be found in your order confirmation email if you purchased the download version directly from onOne Software. If you
purchased a physical copy of Perfect Photo Suite, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect
Photo Suite on two computers. When you enter your license code, Perfect Photo Suite communicates with the onOne activation server and will activate your
software. Your software must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the
internet, you can manually activate your software by following the manual activation instructions in the license dialog.
If you wish to move your copy of Perfect Photo Suite from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Photo Suite and select Deactivate from the Help menu. This will deactivate Perfect Photo Suite on the current machine, allowing
you to install and activate it on another machine.
If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact onOne customer service at 1-888-968-1468 or visit the support section of the onOne software website.
It is important to register your copy of Perfect Photo Suite if you did not purchase it directly from onOne Software, so we can provide you with the best possible
service. Registered users of Perfect Photo Suite are eligible for free technical support, information regarding new versions and products, free updates, upgrade
pricing and special offers on new products.

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.
Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted.
You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products.
You can learn more about the Product Improvement Program here.
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Opening and Saving Files

Supported File Types

Perfect Photo Suite uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file
format that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing
applications. It supports multilayered images and layer masks making it the perfect format for durable, adjusting imaging. Perfect Photo Suite also supports the
opening and saving of the following file types.
Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras
Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Photo Suite and are recommended as your main file format. If your saved
file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer version of
the PSD file format and still maintains all your layers and masks.
You can use the Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not saved directly.
They must be saved as another file type.

Opening Files
You may open an existing file in several ways.
1.
2.
3.
4.

Open the file from the File > Open menu if you are using Perfect Photo Suite as a standalone application.
Dragging a file onto the Perfect Photo Suite icon.
Double-clicking on an image in the Perfect Photo Suite Browser.
Sending a file to Perfect Photo Suite from a host application like Photoshop or Lightroom using the Perfect Photo Suite plug-in.

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Saving Files

1.
2.
3.
4.

You may save the open file using the save option. If you have created a new PSD, you will be prompted to select the name and location of the file.
You may save a copy of the image using the Save As command. This allows you to select the name and location.
You may save flattened images in the TIF, JPG, PNG format from the Save As command in the file menu.
If you have accessed Perfect Photo Suite using a plug-in from another application, follow the instructions from that application for saving.

If you are opening a JPG, TIF, PNG, or RAW file, Perfect Photo Suite will default to saving a new PSD file. To save over the original file, use the
Save As command and select the original file.
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Using Modules
Perfect Photo Suite is a collection of modules, or tools, that work together to accomplish your digital workflow tasks. At the heart of Perfect Photo Suite is the
Perfect Layers module which acts as the host for the other modules. It is responsible for:
The opening and saving of files
Merging multiple files into a single, layered file
Selecting the layer you would like to work on in other modules
Depending on how you access Perfect Photo Suite you may never notice Perfect Layers, but it is there working in the background each time.

The Module Selector
If you access Perfect Photo Suite as a standalone
application you will start in the Perfect Layers module.
This is where you will open your file and prepare it for
editing.
When you are ready, you will select the module you
wish to use from the Module Selector in the upper right
corner of the main window. You can easily switch
between modules by clicking on another in the Module
Selector. This allows you to perform multiple tasks
during the same editing session.
This is the module selector from the Perfect Photo Suite. It contains all of the available modules that
onOne Software makes. If you have purchased a single product, you will only see that product module
When you have completed your work, you return the and Perfect Layers in your module selector.
Perfect Layers module to save your work.
If you access Perfect Photo Suite as a Photoshop Plug-in you will not see the Module selector. You will also not see the module selector if you use the following
modules as plug-ins through Lightroom or Aperture:
Perfect Portrait
Perfect Effects
Perfect B&W
FocalPoint
Perfect Resize
When you access these modules as plug-ins you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically. If you access Perfect Layers or Perfect Mask through Lightroom or Aperture you will start in the Perfect Layers module.

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Layers plug-in. This will start
you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules.
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Using as Standalone
Perfect Photo Suite can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OSX
1.
2.
3.
4.

Open your Hard Drive.
Navigate to the Applications folder.
Navigate to the Perfect Photo Suite folder.
Double click on the Perfect Photo Suite application icon.

You can add Perfect Photo Suite to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use
Launchpad it can be found there as well.

Windows Vista and 7
1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Photo Suite.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Photo Suite from there.

Windows 8
1. Open the Start screen by pressing the Window key.
2. Select Perfect Photo Suite.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Photo Suite from there.
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[Using with Adobe® Photoshop®]
If you have the Premium Edition of Perfect Photo Suite, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the Photoshop
workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for automating and batch
processing.
If you do not have the Premium Edition of Perfect Photo Suite and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition.

To use Perfect Photo Suite inside of Adobe Photoshop follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on. Generally Perfect Photo Suite works
on a copy of your selected layer, not the entire image.
3. From the File menu, select Automate, and then the module you would like
to use.

To use Perfect Photo Suite inside of Adobe Photoshop Elements, follow these
steps:
1. Open the image you want to work on.
2. Select the layer you want to work on. Generally Perfect Photo Suite works
on a copy of your selected layer, not the entire image.
3. From the File menu, select Automation Tools, and then the module you
would like to use.

Perfect Layers is not accessible from Adobe Photoshop or Photoshop Elements.

onOne Panel

Perfect Effects Free
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Users of Adobe Photoshop CS4 and higher can also access Perfect Photo Suite as plug-ins
using the onOne Extension Panel. This provides fast access to the Perfect Photo Suite and
its presets. To access the onOne panel, go the Window > Extensions menu in Photoshop and
select onOne.
The onOne panel behaves just like any other panel in Photoshop. It can be minimized or
nested with other panels. To access a module, simple double-click on it. To use a preset,
single click on the module name. A menu of available presets will be displayed. Simply doubleclick on one to apply it to your selected layer.

If you wish to record actions using Perfect Photo Suite be sure to access it from
the File > Automate menu when recording.

Perfect Effects Free
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[Using with Adobe® Lightroom®]
If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® version of Perfect Photo Suite you can access Perfect Photo Suite as a
plug-in inside of Lightroom. This provides an integrated, round-trip workflow.
Perfect Photo Suite is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Photo Suite with Lightroom.

Plug-In Extras
Perfect Photo Suite can be accessed from the File > Plug-in Extras menu. This is
the preferred way to access it. It gives you access to all installed modules and has
the most flexibility in how the files are handled. To edit an image in Perfect Photo
Suite follow these steps.
1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select the module you would like to use.
When you access Perfect Photo Suite as a plug-in from Lightroom the module
selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same
editing session. At the end of the editing session you must save and close the
image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask your image
will be sent to it directly and when you press Apply, the image is saved and closed
automatically and you are returned back to Lightroom.
Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on which
modules you select.
Perfect Layers or Perfect Mask: Multiple images will be merged into a new,
multilayered file. Then you may access any modules available in the Module
Selector.
All other plug-ins: The first image will be opened in the selected module.
You make your adjustments and then when you hit apply the image is
automatically saved and closed. Then the subsequent images are
processed with the same settings automatically.

Lightroom Plug-in Preferences
When you use Perfect Photo Suite through the Plug-In Extras menu there are
important file handling options that are controlled in the Preferences dialog of the
Perfect Layers module. These need to be configured in advance based on your
desired workflow.
File Type: The file type drop-down menu determines what type of file will
be created. The default is PSD, which maintains layers. You can also select
JPG or TIF if you prefer those formats and are not concerned about
maintaining layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which are saved as
PSD.
Color Space: The color space drop-down menu determines what RGB
working color space is used; Adobe RGB 1998, sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the bit depth,
either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the resolution of
the file.
Stack with Original: When enabled, the new image is stacked with the
original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select a single PSD
file, it will be edited directly, rather than having a copy made.

External Editor
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You can also access modules as external editors for all modules except Perfect
Layers or Perfect Mask. You can access them from the Edit In contextual menu.
These behave similarly to the plug-ins in the Plug-In Extras menu but ignore the
preferences set in Perfect Layers. Instead you have the option to control a subset
of these options each time you access a module, in the same way you do when you
access Photoshop or any other external editor.

Batch Processing
There are two ways to batch process multiple images in Lightroom with Perfect Photo Suite. It depends on the number of images that you want to process and
where you want them saved as to which method is best.
Small Batches
If you have a small number of images you can batch process them using the same method you would process a single image using the plug-in from the Plug-in
Extras menu. A good example would be two similar images that you would like to process the same way. Follow these steps.
1.
2.
3.
4.

Select both images.
Go to the Plug-in Extras menu and select the module you would like to use.
The first image will open in the module, do your work.
Press Apply.

The first image will be saved and closed automatically. The second image will be opened in the module and the settings used on the first image will be applied
automatically, then it will be saved and closed and you will be returned to Lightroom.

Remember, you can't batch process with Perfect Layers or Perfect Mask, your images will be stacked to create a new multilayered file
instead.
If you need to use brushes to apply effects, you should not batch process as brushing is not repeated on multiple images.

Large Batches

If you need to batch process a large number of images, or control the
file size, naming or save to location you should batch process through
Lightroom's Export dialog, located in the File menu. Batch processing
through Export is driven by presets, so you need to create a preset that
accomplishes the work you desire first.
1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select the module to
use.
4. Complete the module specific options below. These will start with
the preset, followed by options for selecting the export location,
file naming, file size, etc.
5. Press the export button.

You cannot save Lightroom export presets or use the Export with Previous option.
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[Using with Apple® Aperture®]
If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® Edition of Perfect Photo Suite you can access Perfect Photo Suite as a
plug-in inside of Aperture. This provides an integrated, round-trip workflow.

Perfect Photo Suite integrates tightly with Apple Aperture and provides a seamless
experience for enhancing your images.
Perfect Photo Suite can be accessed from the Photo > Edit with Plug-In menu. To
edit an image in Perfect Photo Suite follow these steps.
1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.
When you access Perfect Photo Suite as a plug-in from Aperture the module
selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same
editing session. At the end of the editing session you must save and close the
image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask your image
will be sent to it directly and when you press Apply, the image is saved and closed
automatically and you are returned back to Aperture.
Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on which
modules you select.
Perfect Layers or Perfect Mask: Multiple images will be merged into a new,
multilayered file. Then you may access any modules available in the Module
Selector.
All other plug-ins: The first image will be opened in the selected module.
You make your adjustments and then when you hit apply the image is
automatically saved and closed. Then the subsequent images are
processed with the same settings automatically.

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Photo Suite will
maintain the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store
re-editable layers and mask.
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Using with Other Applications
You can use Perfect Photo Suite as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application
user guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include
selecting Perfect Photo Suite setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto.

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option
(note if you have ever selected another external editor, it may be
listed here instead.)
4. From the Choose dialog that appears, navigate the the Perfect
Layers folder, inside the Applications folder and select Perfect
Layers.
5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .

Perfect Effects Free
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Perfect Effects Free
Perfect Effects gives photographers a fast and powerful way to create images with
impact.
It includes an updated library of professional quality photographic effects that can be previewed live
on your image before being applied. Live previews are shown in full screen so you can see your image
at its best. You'll enjoy the ability to stack multiple effects together to create your own unique look.
Perfect Effects takes the idea of stacking effects further with updated blending options that provide
better control over how effects are combined. These advanced tools include blending modes options
and the ability to limit effects to specific color or tonal ranges of an image.

Perfect Effects Free
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Getting Started
This getting started section will give you the basics of using Perfect Effects. If you have never used Perfect Effects before this is a good place to start. You can
also watch the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the Using Perfect
Effects section instead.
When to use Perfect Effects
The broad range of effects in Perfect Effects makes it useful at many steps in the digital workflow. For example, the effects in the Brightness, Contrast and
Color Correction categories may be used early in the workflow for correcting the color and tone of an image. While effects in many categories are designed for
more artistic effect, may be used in the middle of the process. Finally, Perfect Effects has several effects designed for sharpening in the Sharpening category
that should be applied as the last step before printing.

Perfect Effects Free

Perfect Effects Free 20

User Interface
Perfect Effects Free Main Window:

A. Effects Browser: This library of effects is located on the left side of the window for easy browsing.
B. Tool Well: This is where the tools are located.
C. Preview Window: This is the main section where you preview and work on images.
D. Tools Option Bar: This is where information and options about each tool is set.
E. Module Selector: This is where you choose which software module to open.
F. Navigator, Loupe and Histogram Pane: This pane will access the Navigational, Loupe and Histogram features.
G. Effects Stack: This is where you view and stack effects.
H. Cancel/Apply Buttons: This is where you cancel or apply an action.

The Perfect Effects Tool Well
There are four different tools in the Perfect Effects tool well. More details about each tool will be covered in the next chapters.

Masking Brush

This masks out areas using brush strokes to expose underlying layers.

Masking Bug

This tool lets you mask out the layer to expose the original

Hand Tool

This tool drags your image within the preview window when it's larger than the viewable area.

Zoom Tool

This tool changes the magnification in the preview window.

underlying image.

Perfect Effects Free
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Navigating the Preview
Perfect Effects Free
This provides several ways to navigate and view your image in the Preview window.

The Preview Window above is the main section where you preview and work on images.
Hand Tool
The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area.
To pan (scroll) in the Preview window:
Select the Hand Tool and drag the image until you locate the area you wish to view.
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool
The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:
Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.

Perfect Effects Free
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Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane
This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region.
At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate.
FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

The Loupe Pane
This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.
At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

The Histogram Pane
This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.
The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.
The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane
The info pane will display important metadata about your file including:
Camera type
File type
Focal length and lens information
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions
File Size and Bit Depth
If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.
The Info panel is not visible when you access Perfect Effects Free as a Photoshop
plug-in.
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Preview Window Modes
The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a button
that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen.

Left-Right Screen.

Top-Bottom Screen.

Top-Bottom Split Screen.

Left-Right Split Screen.

Tip: You can use the
keyboard shortcuts below
to quickly switch view
modes. Items in
parenthesis are for
Windows.

Command
(Control)
L:
CommandOption
(ControlAlt) L:
Command
(Control)
T:
CommandOption
(ControlAlt) T:
Command
(Control)
Y:

Change the
preview
mode to
Left/Right.
Change the
preview
mode to
Left/Right
Split screen.
Change the
preview
mode to
Top/Bottom.
Change the
preview
mode to
Top/Bottom
Split screen.
Change the
view mode
to single
image.
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Using Perfect Effects
Perfect Effects is designed to work in steps by adding and adjusting multiple effects on top of each other. If you are a photographer, think of this like adding
filters over your cameras lens. First, you would add a polarizer to increase the contrast. Next you would add a graduated neutral density filter to darken the sky
and perhaps add a vignette lens hood to darken the edges. This same concept is what drives Perfect Effects, except you have many more filters and more
flexibility and control.
Perfect Effects provides several ways to work depending on your skill level. It works for beginners through advanced users. Below are example workflows for
different levels.

Beginner
A new user can simply click on an effect and apply it. This is the easiest way to get started.
1. Start by opening an image into Perfect Effects.
2. On the left side you will see the Browser with a list of categories. Click on a category to open up a series of effects. You will now see your image with
different effects applied.
3. Simply click on the effect you like and press the Apply button.

Intermediate
An intermediate user may try stacking effects and adjusting their strength.
1.
2.
3.
4.
5.

Start by opening an image into Perfect Effects.
Add an effect from the Browser, adjust its strength with the strength slider at the bottom of the Effect Stack pane on the right.
Add another effect layer by pressing the Add button in the Effect Stack pane, then select a new effect from the library.
Continue to add effect layers and adjusting each effects strength.
When you have created an effect stack you like, press the Apply button.
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Browsing Effects
Built into Perfect Effects is a browser, located in the left panel. You can use it to browse the factory supplied effects, presets you have created or downloaded
from the onOne website or for marking and finding your favorites. Below is a description of the controls in the browser.

A. Browser Tabs: This switches between the Browser tab and the Extras tab. The Extras tab displays
the included backgrounds, borders and textures.

B. Folder Tree: This drop-down menu displays the folder paths above the folder you are browsing. You

can use this to quickly navigate up the folder tree. The currently selected root folder is displayed here as
well.
C. Search Field: Use the search field to locate files in the current sub-folder. Simply start to type and
your results will appear in a new sub-folder called search results while you type.
D. Image File: A file is displayed as a thumbnail of the image and will have the filename and extension
listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of the
browser or close it.
F. File Info: This window will show captured and modified dates, color space, exposure settings and size
on disk if applicable.
G. Browser Modes: These icons control the browser views. One column, two column, three column or
list view.
H. Quick View Browser Button: Press this button to open the current folder in the Quick View
Browser.

Browser Tabs
The Browser is divided into three tabs; Effects, Favorites and My Presets.
Effects: The Effects tab contains the factory effects provided by onOne Software.
Favorites: When you click on the favorite flag on an Effect or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to
find the effects and presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne website, they will be located here.

Navigating the Browser
To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, effect or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

You cannot move or delete presets from the browser.

Selecting an Effect or Preset to Use
To activate an effect or preset on your image, simply click on it.
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Searching
To search for effects or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up
To view a larger preview on an effect or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser
The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four
viewing modes. Three that
display thumbnails in
columns and one list view.
The browser modes are
selected using the browser
mode icons at the bottom
of the browser.

single column view

Quick View Browser
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two column view

list view
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The Quick View Browser adds an
elegant full-screen view of your
images, effects and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.
Browse folders and
images quickly to find
the right one to work on.
View all your effect or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate.
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.
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Using the Effects Stack
The Effects Stack is a list of all effects and presets added to an image.
When you add an effect to your image, it will appear on the current Effect
Layer in the Effects Stack pane. The Stack works similar to the Layers or
History palettes in Photoshop, or the Stack in PhotoTools. At the bottom of
the Effects Stack is your original image. Each effect you select in the
Library will replace the effect on the currently selected Effect Layer.
You can create as many Effect Layers as needed.

You move forward and backward in time by selecting different Effect Layers in the Stack.
For example, if you had an Effects Stack with the original and three Effects Layers applied, you could go back to the first Effect by selecting it in the
Effects Stack. The second and third Effects Layers will appear disabled and your preview will show only the results of the original with the first Effect Layer
applied. You can then click on the third Effect Layer, the most recently applied, and the second and third effects will appear active again and the preview
will show the results of all three effects. The results of each Effect Layer in Perfect Effects are cumulative, so the results of the first effect are passed to
the second effect and so forth.
It is best to work with Perfect Effects in a step-by-step process, knowing that the results from each step are the starting point for the next effect. This
means that when selecting the effects to apply, think about the workflow order you use.
It is best to make color and tonal adjustments first, followed by special effects and finish with final touches such as vignettes and sharpening. Thinking of
the proper steps to add effects in Perfect Effects will give you better and faster results.
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Changing the Current Effect
When you start in Perfect Effects, there will be an empty Effect Layer on
top of your original. Your original is at the bottom of the Effect Stack. To
add an effect to the empty Effect Layer, select it first, then click on an
effect thumbnail in the Effects Browser. You can change the effect in an
Effect Layer by clicking a different effect thumbnail in the Effect Library.

Adding Effects
To add another Effect Layer so you can stack multiple effects, click the
Add button at the bottom of the Effects Stack. This creates a new empty
Effect Layer. Then select another effect from the Effect Browser.
You can also double-click on an effect in the Effect Browser to place it in
the current Effect Layer and add a new empty Effect Layer above it.

Hiding Effects
An effect may be temporarily hidden or revealed by pressing the Eye icon
next to the effect in the Stack. When you hide an effect, you are not
removing it from the Stack. You can reveal it again anytime. Keep in mind
that hiding an effect in the middle of the Stack may take a moment to rerender and update your preview.

Changing Effect Order
Effects may be reordered in the Stack by clicking and dragging them into
the desired position. Reordering effects can have a huge difference on the
results of the image. Reordering effects will cause the Stack to re-render
which may take a few moments.

Deleting an Effect
You remove an effect by selecting it and pressing the Delete button at the
bottom of the Effects Stack or by pressing the delete key on your
keyboard.

Tip: You can clear all the effects from the Frame Stack at once
by option (alt on Windows) clicking on the delete button.

Adjusting the Amount
The Amount slider controls how the selected effect blends with the previous effect or the original image. You adjust the amount for any effect by selecting
it and then adjusting the Amount slider. Adjusting the Amount slider effectively adjusts the strength, or opacity of an effect. For example, if you add a
black and white conversion effect, sliding the amount down will reveal some of the color from the previous state. Usually, the Amount slider will be set to
100% when you add an effect, however with some effects like vignettes and soft focus effects, it may be set at 50%.
Adjusting the Amount slider to greater than 50% will make the effect stronger, while adjusting it to less than 50% will make the effect weaker.

Expanding a Preset
If your current Effect Layer contains a user-created preset you can expand it, revealing all the steps (Effect Layers) in the preset. This allows you to
adjust the strength or blending options for each Effect Layer. A preset will be labeled in italics and the expand button will be enabled.
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Blending Options

Selecting the Options button will bring up the Blending Options
window. This window offers advanced blending options between effects.

The blending options controls are:
Blending Mode: A pop-up list of blending modes. The list includes normal, lighten, darken, screen, multiply, softlight, hardlight, overlay and color.
Amount: The Amount control is reproduced here for convenience. Amount is measured in percentage with a range from zero to 100.
Apply Effect To: A pop-up list of color or tonal ranges will appear, only one may be selected. The options are; all, highlights, midtones, shadows,
reds, greens, blues, magentas, cyans, yellows, flesh colors, vivid colors and neutrals. This applied effect creates a selection based on the lightness, hue,
or saturation range specified. There is a Fuzziness slider associated with this control that adjusts the hardness or precision of the selection. The range is
zero to 100.
Protect: The protect sliders are used to remove an effect from a specific color or tonal range. The sliders are; highlights, shadows and flesh colors. The
selection created should be feathered and appear natural. The default for these sliders is zero; the range is zero to 64. The range for Flesh Colors is zero
to 100.
Flesh Ethnicity: These select the range of colors used for the flesh color options above. The ethnicity ranges include; Caucasian, African, Latin,
Asian, Middle Eastern and All.
Reset: This resets all settings to the original default settings.
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Using the Masking Tools
Perfect Effect users can choose the Masking Brush or Masking Bug to selectively apply each effect to the image. This opens a whole new world of control for
Perfect Effects. Using the Masking tools is just like using a layer mask in Photoshop to hide or reveal the effect in specific, user-defined areas of the image. The
Masking tools even support pressure-sensitive Wacom tablets for the ultimate in control.
You can think of masking as painting with black paint on white
paper.
A white mask reveals all the effect that the mask is attached
to. An all white mask is considered blank or empty and shows all
the selected effect. As you use the masking tools, you are
adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current effect, allowing the effect(s)
under it to show through. Think of it like cutting a hole in the
mask. If you make a mistake, you can switch your paint color to
white (Paint-In mode) and paint the effect back in like an
eraser. When you paint you have more than just white or
black, but any shade of gray in between depending on the
opacity of the brush. Shades of gray partially hide the layer,
blending the layers together.
Each effect layer in Perfect Layers has a mask automatically
added to it. This allows you blend each effect differently.
There are several global masking options that can be accessed
from either the masking tools Tool Options Bars or the Masking
Menu. They affect the entire mask on the selected effect layer.

Reset Mask
Reseting a mask returns it to all white. The entire layer is
visible.

Invert Mask
Invert swaps the white for black and black for white. What was
hidden is now revealed and vice-versa. Inverting a mask can be
very useful. It allows you to paint a layer in, rather than out,
which is handy if you only want to work with a small area.

Copy and Paste Mask
Perfect Layers allows you to copy the mask from one effect
layer to another. This is handy if you have painted a complex
mask on one layer for an adjustment and you wish to use the
same mask on another layer for a different adjustment. To
copy or paste a mask, use the Copy Mask and Paste Mask
commands from the Masking menu.

Paint-In Effects
Some of the effects in Perfect Effects are designed to be painted-in. When you add them to your
image, you will not see the image change, but the Masking Brush will be selected automatically. Simply
paint where you would like the effect to be applied.
You can identify Paint-In effects by the paint-brush icon in the upper left corner of the thumbnail.
Most of the Paint-In effects are located in the Basic Brushes category.
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Mask Modes
Mask Mode allows you to view your image mask in several ways.

The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.

A close-up of the Mask View Modes

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several
modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are examples of the
different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard shortcut.

Mask-Red

Mask-White

The masked area appears as
50% red. This is similar to the
Quick Mask view in Photoshop.

The masked area
appears as solid
white.

Mask-Dark

Mask-Grayscale

The masked area appears as
90% black.
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The masked area
appears as black.
The unmasked
areas appear as
white. This is the
same as viewing a
layer mask in
Photoshop.
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Using the Masking Brush
The Masking Brush: The Masking Brush functions like a brush tool for masking layers.
The Masking Brush is one of two tools in Perfect Effects for masking effects. When
you select the Masking Brush, your tool icon changes to a circle that represents
the size of the brush. It may also appear as two concentric circles (see below),
indicating the inner hard edge and outer soft edge of the brush if the feather
control is set above zero. There is also either a plus or minus in the center of the
brush. Minus means the brush mode is set to paint-out, plus means it is set to
paint-in.

How to use the Masking Brush
To use the Masking Brush, select it in the tool well. Make sure you are on the effect you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying effect(s) appear.
If you make a mistake while brushing you have several options to correct them:
First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.
How to control the Masking Brush
The Masking Brush Tool Options Bar

Paint Mode
The paint mode controls is you are Painting-Out (hiding the effect) or Painting-In (restoring the effect). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in. You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily.
Invert Mask
Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask by pressing the Invert button in the
Tool Options Bar.
Reset Mask
Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.
Brush Size
You can control the size of the brush using the Size pop-up in the Tool Options
Bar. You use a small brush at high magnification for precise work, and a large
brush at fit to screen for general work. To the right, you can see examples of
brush strokes at varying sizes. You can control the size of the brush several
ways:
Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [ ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.
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Feather
You control the amount of feathering or hardness of the brush by using the
Feather pop-up in the Tool Options Bar. The feather has a range from 1 to 100
percent. You use a small feather at high magnification for precise, hard-edged
work and a large, soft-edged brush at fit to screen for general work. You can
visually see your feather by watching the outer concentric circle of the brush tool.
To the right you can see examples of different feather options. You can control
the size of the brush several ways:
Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [ ] ).

Opacity
You can control the opacity, or strength of the brush with the Opacity pop-up in
the Tool Options Bar. Think of the opacity as the shade of gray you are painting
with. The opacity has a range from 1 to 100 percent. You use a high opacity to
paint quickly and hide large areas. You use a lower opacity for blending areas
together or for subtle work. To the right you can see examples of different
opacity options. You can control the size of the brush several ways:
Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

Wacom® Controls
Perfect Layers supports pressure sensitive Wacom tablets. When you use the
Masking Brush you can enable pressure sensitive controls for the brush size,
brush opacity, or both simultaneously. Click on the W button next to each control
in the Tool Options Bar to activate the pressure sensitive controls.
The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right
you can see examples of how pressure sensitivity can be used to control the
Masking Brush.
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Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from
being applied across edges. A great of example of using the Perfect Brush option
would be to mask a sky along a horizon of mountains.

Tip: You can turn the Perfect Brush on and off using the command or
control -r keyboard shortcut. You can also temporarily lock the color to
remove by holding down the control key(win) or command key(mac). This
is useful when brushing through areas with a lot of openings like tree
branches.
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Using the Masking Bug
Masking Bug: This is used for masking effects by creating gradient masks in either a round or rectangular shape.
The Masking Bug is perfect for tasks like darkening skies, creating vignettes and graduated filters. Learning to use the Masking Bug is fast and easy. All the
adjustments made with the Masking Bug are live and readjustable while using the Masking Bug... so don't be afraid to experiment with it. To use the Masking
Bug, select it in the tool well. Select the effect you wish to mask. Now click the center of the area you wish to mask out. A new rectangular Masking Bug appears
where you click. You can change the shape from rectangle to round by using the Shape pop-up menu in the Tool Options Bar.
Adjusting the Masking Bug

Learning to use the Masking Bug is easy and fun. Start by adding a Masking Bug to a layer and then set the Mask View mode to Mask - Grayscale. This will
let you see the Masking Bug in simple black and white.
Start by moving the Masking Bug. Click and drag inside the center square or circle.
Now change the size and angle by clicking and dragging on the the legs. The legs are the shorter limbs with closed terminals. As you pull the legs
the bug gets larger. As you twist the legs the Masking Bug rotates.
Now adjust the feather by changing the angle of the right antenna. The antennas are the longer limbs with the open terminals.
The right antenna length changes the opacity of the current layer. You won't see any change when the grayscale mask preview in on.
The left antenna length controls the opacity of the Masking Bug.
Finally tilt the Masking Bug by holding down the option (Mac OSX) or alt (Windows) key and click and drag in the body. This will tilt the plan of the
bug in 3D. You can use this to change the feather or shape of the Masking Bug. To reset the angle, hold the option or alt key and double-click in
the body.
You can adjust the Masking Bug while the Masking Bug tool is selected. When you change layers or switch to another tool the mask created by the
Masking Bug is rendered. If you want to use the Masking Bug again on the same layer the old Masking Bug will be replaced and you simply start
again.

Masking Bug Tool Options

Below is the Tool Options Bar that contains the controls for the Masking Bug.
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Feather
You can control the amount of feathering or hardness of the edge of the
Masking Bug using the Feather Slider. The feather has a range from 1 to 100
percent. You use a small feather to create a hard edge, a soft feather for a
larger, softer transition. To the right you can see examples of different feather
options.
You control the feather by:
Using the Feather Slider in the tool options bar.
Changing the angle of the right antenna.

Hard Feather 0%

Soft Feather 50%

100% Opacity

50% Opacity

Round Masking Bug

Rectangular Masking Bug

Opacity
You can control the opacity, or strength of the Masking Bug with the Opacity
Slider. The opacity has a range from 1 to 100 percent. You use a high opacity to
completely hide the area under the Masking Bug. You use a lower opacity for
blending areas together or for subtle work. To the right you can see examples
of different opacity options.
You can control the opacity several ways:
Using the Opacity Slider in the tool options bar.
Changing the length of the left antenna.

Shape
This controls the shape of the masking area. You can choose none, round or
rectangle.
Use the round Masking Bug to create vignettes or soft, round masks.
Use the rectangular Masking Bug to swap skies, add gradient filters,
etc.
Use the none option to remove an existing Masking Bug from a layer.

Grid
This turns on or off the ability to view a grid that represents the area effected
by the mask. You can also set this to Auto and the grid will appear only when
making adjustments then turn off after the adjustment is made.
Invert Mask
Invert swaps the white for black and black for white. What was hidden is now
revealed and vice-versa. Inverting a mask can be very useful. It allows you to
remove what is outside the Masking Bug rather than what is contained within.
You can invert the mask with the command (Mac OS X) or control (Windows) i
keyboard shortcut.
Reset Mask
Reseting a mask returns it to all white. The entire layer is visible.
Retouching the Masking Bug
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Retouching the Masking Bug
You can retouch the Masking Bug with the Masking Brush. The mask created by the Masking Brush sits on top of and overrides the Masking Bug.
You can add to a Masking Bug with the Masking Brush when the paint mode is set to Paint-Out.
You can subtract from a Masking Bug with the Masking Brush when the paint mode is set to Paint-In.
Masking Bug View Options
There are several options for viewing the Masking Bug, located in the Mask Menu:
Masking Bug Tool Opacity: Not to be confused with the opacity of the mask. This option controls how visible the Masking Bug tool outline
appears on screen. If the Masking Bug is interfering with the view of the image, you can turn it down to make it more subtle. This control has no
effect on how the image itself appears.
Masking Bug Grid: This allows you to turn the grid that appears under the Masking Bug on or off. Normally, it is set to Auto, where the grid will
appear while you are adjusting the Masking Bug only.
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Presets
Presets store the Effect Stack and all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent
results. You can save your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset
Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset
Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset.
The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.
In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location.

Deleting a Preset
You can remove a preset from Perfect Effects if you no longer want to
have access to it. To remove a preset, follow these steps:
1. Open Perfect Effects.
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets
You can import presets you have downloaded from the onOne website
using these steps.
1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.
2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.
That's it, next time you use Perfect Effects the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Effects.
You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Portrait, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONEffects extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Menus
Perfect Effects Free
About: Opens the about box. This dialog contains your serial number, version
number and information on contacting onOne Software for support.
Preferences: Opens the preferences dialog.
Quit: Quits the application.

File
Apply: Applies the current effect Stack and options to your image and returns
to the host application.
Cancel: Cancels Perfect Effects and returns back to the host application with
no changes.

Edit
Undo: Reverses the last user action.
Redo: Reapplies the last user action if it has been undone.
Undo Stroke: If the last action was a brush stroke, this reverses the entire
brush stroke.
Redo Stroke: If your last action was an undo of a Brush Stroke, this reapplies
the entire stroke.
Cut: Cuts the current text into the clipboard.
Copy: Copies the current text into the clipboard.
Paste: Pastes the content of the clipboard.
Reset All: Resets all the floating palette controls back to their default settings.
Preferences (Windows Only): Opens the Perfect Effects preferences
dialog.

Mask
Invert Mask: Inverts the mask, what was hidden is revealed and vice versa.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask.
Paste Mask: Pastes the mask.
Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool
overlay. This has no effect on the image, just how obvious the Masking Bug tool
is on screen.
Masking Bug Grid: Sets the grid mode for the Masking Bug.
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Preset
Save Preset: Saves the current Effect Stack as a new preset.
Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.
Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.
Delete Preset: Deletes the current preset.
Edit Preset Info: Opens the preset dialog so you can edit the name, author or
description information.

View
Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.
Zoom Out: Zooms the preview window out one increment. This will make the
preview image smaller.
Fit to Screen: This sets the preview image so that the entire image is on
screen at once. Think of this as an overview of the entire image. This is the
setting you will use most of the time.
Fill: If the target layer is smaller than the canvas size, it sets the zoom to fill the
preview with the target layer.
Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.
Show Browser Pop-up: Enables the browser pop-up window.
Browser Mode: Allows the user to select how the Browser Library displays the
categories.
Show Clipping: Shows the clipping overlay view, which over-rides
the current mask view.
Show Preview: Toggle to enable or disable the preview.
Preview Mode: Allows the user to switch preview modes.
Preview Background Color: Toggles the background color options.
Show Mask: Allows the viewer to see the mask.
Mask View Mode: Allows the user to select the various mask modes.

Window
Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.
Effects Stack: Hides or shows the Effects Stack pane.
Effect Options: Hides or shows the Effect Options pane. Effect Options is only
available in Advanced mode.
Show Browser Panel: Hides or shows the Browser Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Full Screen: Toggles to and from full screen mode.
Document Name: Shows the name, zoom level and bit depth of the open
image.
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Help
Search: Mac OSX only. Searches the menus options.
Perfect Effects Online Help: Opens this html Help in your default web
browser.
Video Tutorials: Opens the online Video Tutorial in your default web browser.
Getting Started: Opens the getting started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.
About Perfect Effects (Windows Only): Opens the about box with the
version number and license code displayed.
Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts
Perfect Effects has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action

Mac

Win

Apply

cmd s

ctl s

Cancel

esc, cmd w, cmd . esc, ctl w

Save Preset

cmd shift s

ctl shift s

Preferences

cmd ,

ctl k

Undo

cmd z

ctl z

Redo

cmd shift z

ctl shift z

Cut

cmd x

ctl x

Undo Stroke

cmd opt z

ctl alt z

Redo Stroke

cmd shift opt z

ctl shift alt z

Copy

cmd c

ctl c

Paste

cmd v

ctl v

Reset All

cmd opt z

ctl alt z

Open/Close Navigator

cmd 1

ctl 1

Open/Close Effect Stack

cmd 2

ctl 2
ctl 3

Open/Close Effect Options

cmd 3

Hide Browser Panel

cmd left arrow

ctl left arrow

Hide Control Panel

cmd right arrow

ctl right arrow

Hide Panels

tab

tab

Fullscreen Mode

cmd ctl f

F11
h

Select Pan Tool

h

Select Zoom Tool

z

z

Select MaskingBrush

b

b
n

Select MaskingBug

n

Zoom-In

cmd + or cmd =

ctl + pr ctl =

Zoom-Out

cmd -

ctl -

1:1

cmd opt 0

ctl alt 0

Fit to Screen

cmd 0

ctl 0

Fill with layer

cmd shift 0

Brush Size

larger ]
smaller [

larger ]
smaller [

Brush Feather

softer shift ]
harder shift [

softer shift ]
harder shift [

Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
opt ]
opt [

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
alt ]
alt [

Enable or disable Perfect Brush cmd r

ctl shift 0

ctl r

Toggle Brush Mode

x
opt

x
alt

Show Mask

ctl m

ctl m

Preview on/off

cmd p

ctl p

Preview Modes
- Single Image
- Left/Right
- Left/Right Split
- Top/Bottom
- Top/Bottom Split

cmd Y
cmd L
cmd opt L
cmd T
cmd opt T

ctl Y
ctl L
ctl opt L
ctl T
ctl opt T

Show Quick View Browswer

cmd up

ctl up

Change Effect Layer Strength

number keys
1 - 10%
2 - 20%
etc

number keys
1 - 10%
2 - 20%
etc
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Adjusting the Masking Bug 37
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applying a preset 29

B
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blending 29
Bridge 17
Browser 26
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Brush Opacity 34
Brush Size 34

C
changing order of effect 29
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Contacting onOne Software 4
copy mask 32

D
Deactive 8
deleting a preset 40
deleting an effect 29
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E
Edit with Plug-in 16
Effects 29
Effects Stack 29
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expanding a preset 29
Export 16 ,14
External Editor 16 ,14 ,17

F
FAQ 5
File Browser 26
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File Menu 26
Folder 26
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G
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H
hand tool 21
Help 5 ,3
hiding effects 29
Histogram 22

I
importing a preset 40
Installation 7
Introduction 2
invert mask 32 ,34
iPhoto 17

K
Keyboard shortcuts 44
Knowledge Base 5

L
Left-Right Screen 24
Left-Right Split Screen 24
Legal 4
Licensing 8
Lightroom 14
Loupe 22

M
Mac OSX 6
masking brush 32 ,34
masking bug 32 ,37 ,34
Masking Bug Tool 37
Masking Bug Tool Options Bar 37
Masking tools 32
Menus
Module Selector 10

N
Navigator 22

O
onOne Panel 12
onOne Software 4
onOne University 5
OpenGL 6
Opening 9

P
paint in effects 32
Paint Mode 34
paste mask 32
PDF 3
Perfect Layers 10

Phone
Photoshop 12
Photoshop Elements 12
Plug-In Extras 14
PNG 9
presets 40
Preview window 21
Preview Window Modes 33 ,24
Printing 3
PSB 9
PSD 9

R
RAW 9
Registration 8
reset mask 32 ,34

S
Save As 9
Saving 9
saving a preset 40
sharing a preset 40
Show Mask 34
Single Mode Screen 24
soom tool 21
Standalone 11
Support 4
Support File Types 9
System Requirements 6

T
Tablet 3
The Mask Modes 33
TIF 9
Tool Well 20
Top-Bottom Screen 24
Top-Bottom Split Screen 24

U
Uninstalling 7
User Guide 1
User Interface 20
User Interface 19
Using a preset 40
Using Modules 10
Using Perfect Effects 25
Using the Help System 3
Using with Photoshop 12

V
Video Tutorials 5

W
Wacom 34
Webinar 5
welcome 18
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